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Important Information

Warranty
The PC/104-GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the
date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace
equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability
of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any
action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein
does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National
Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse,
misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

Trademarks
LabVIEW®, NAT4882®, NI-488®, Turbo488®, HS488™, NI-488.2™, TNT4882™, and TNT4882C™ are trademarks of
National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical or
clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the user
or application designer. Any use or application of National Instruments products for or involving medical or clinical
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always
continue to be used when National Instruments products are being used. National Instruments products are NOT intended
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health
and safety in medical or clinical treatment.



FCC/DOC

Radio Frequency Interference

Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and
used in strict accordance with the instructions in this manual, may cause
interference to radio and television reception. Classification requirements are the
same for the Federal Communications Commission (FCC) and the Canadian
Department of Communications (DOC). This equipment has been tested and found
to comply with the following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his
own expense.

Notices to User: Changes or modifications not expressly approved by National
Instruments could void the user’s authority to operate the
equipment under the FCC Rules.

This device complies with the FCC rules only if used with
shielded interface cables of suitable quality and construction.
National Instruments used such cables to test this device and
provides them for sale to the user. The use of inferior or
nonshielded interface cables could void the user's authority to
operate the equipment under the FCC rules.

If necessary, consult National Instruments or an experienced radio/television
technician for additional suggestions. The following booklet prepared by the FCC
may also be helpful:  Interference to Home Electronic Entertainment Equipment
Handbook. This booklet is available from the U.S. Government Printing Office,
Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement
sur le matériel brouilleur du Canada.
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About

This

Manual

This manual contains instructions to help you install and configure the

National Instruments PC/104-GPIB interface module and the NI-488.2M

software for Windows NT. The interface module is intended for use in a

PC/104-based system.

This manual assumes that you are already familiar with Windows NT.
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Use this getting started manual to install and configure your

PC/104-GPIB and the NI-488.2M software for Windows NT.

Use the NI-488.2M User Manual for Windows 95 and Windows NT to

learn the basics of GPIB and how to develop an application program. The

User Manual also contains debugging information and detailed examples.

Use the NI-488.2M Function Reference Manual for Win32 for specific

NI-488 function and NI-488.2 routine information, such as format,

parameters, and possible errors.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what

you need to get started, and briefly describes the PC/104-GPIB and

the NI-488.2M software for Windows NT.

• Chapter 2, Hardware Configuration and Installation, contains

instructions to help you configure and install your PC/104-GPIB.

• Chapter 3, Software Installation and Configuration, contains

instructions to help you install and configure your NI-488.2M

software for Windows NT.

• Chapter 4, Installation Verification, describes how to verify the

hardware and software installation.

• Chapter 5, Using the GPIB Software, helps you get started with the

NI-488.2M software for Windows NT.

• Appendix A, Troubleshooting and Common Questions, contains

troubleshooting information and the answers to common questions.

• Appendix B, Specifications, describes the physical characteristics of

the PC/104-GPIB and the transfer rates of the NI-488.2M software,

along with the recommended operating conditions.

• Appendix C, Customer Communication, contains forms you can use

to request help from National Instruments or to comment on our

products and manuals.

• The Glossary contains an alphabetical list and a description of terms

used in this manual, including abbreviations, acronyms, metric

prefixes, mnemonics, and symbols.
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Conventions Used in This Manual

The following conventions appear in this manual.

» The » symbol leads you through nested menu items and dialog box

options to a final action. The sequence File»Page

Setup»Options»Substitute Fonts directs you to pull down the File

menu, select the Page Setup item, select Options, and finally select the

Substitute Fonts options from the last dialog box.

bold Bold text denotes the names of menus, menu items, parameters, dialog

boxes, dialog box buttons or options, icons, windows, or LEDs.

bold italic Bold italic text denotes a note, caution, or warning.

bold Bold text in this font denotes the messages and responses that the

monospace system automatically prints to the screen. This font also emphasizes lines

of code that are unique.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard

IEEE 488.2 488.1-1987 and the ANSI/IEEE Standard 488.2-1992, respectively,

which define the GPIB.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key

concept. This font also denotes text for which you supply the appropriate

word or value.

italic Italic text in this font denotes that you must supply the appropriate words

monospace or values in place of these items.

monospace Text in this font denotes text or characters that you should enter from the

keyboard, sections of code, programming examples, and syntax

examples. This font can also denote the proper names of disk drives,

paths, directories, programs, subprograms, subroutines, device names,

functions, operations, variables, filenames and extensions, and for

statements and comments taken from programs.

Related Documentation

The following documents contain information that you may find helpful

as you read this manual.

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface

for Programmable Instrumentation
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• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats,

Protocols, and Common Commands

• Microsoft Windows NT User's Guide, Microsoft Corporation

• PC/104 Specification, Version 2.3

Customer Communication

National Instruments wants to receive your comments on our products

and manuals. We are interested in the applications you develop with our

products, and we want to help if you have problems with them. To make

it easy for you to contact us, this manual contains comment and

configuration forms for you to complete. These forms are in Appendix C,

Customer Communication, at the end of this manual.
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Introduction

1
Chapter

This chapter explains how to use this manual, lists what you need to get

started, and briefly describes the PC/104-GPIB and the NI-488.2M

software for Windows NT.

How to Use This Manual

No

Yes

Gather What You Need
to Get Started

Chapter 3

User Manual and
Function Reference

Manual

Chapter 1

Write Application Program

Need to
Change Software

Settings?

Configure the Hardware (Optional)

Install the Hardware

Install the Software

Verify the Installation

Yes

No
Passes?

Run Interactive Control Utility

Review Programming
Considerations

Configure the Software

Troubleshooting

Chapter 4

Chapter 5

Chapter 2



Chapter 1    Introduction

PC/104-GPIB for Windows NT 1-2 © National Instruments Corporation

What You Need to Get Started

Make sure you have all of the items listed before you attempt to install

the hardware and software.

❑ Windows NT version 3.51 or higher installed on your system

❑ One of the following modules, which your kit contains:

16-bit PC/104-GPIB

8-bit PC/104-GPIB

❑ PC/104 installation kit, which your kit contains:

Four standoffs

Four screws

Four hex nuts

20 in. GPIB connection ribbon cable

❑ The following 3.5 in., high density (1.44 MB) disks, which your kit

contains:

GPIB Software for Windows NT (Setup Disk)

GPIB Software for Windows NT (NI-488.2M Software)

❑ GPIB cables—single-shielded or double-shielded, Type X1, X2, or

X5, which you can order from National Instruments

Optional Equipment

Call National Instruments for more information about the following

optional equipment.

• Serial or parallel bus extender and cables

• Bus expander/isolator

• GPIB mechanical switch

GPIB Hardware Overview

The PC/104 Specification, Version 2.3 defines a compact version of the

PC AT bus that is optimized for embedded systems applications. Unlike

ISA boards that are installed in a fixed computer backplane, PC/104
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modules are stacked, one on top of the other. Modules are available in

8-bit and 16-bit versions, which correspond to the PC and PC AT bus

implementations, respectively.

The PC/104-GPIB, equipped with a TNT4882C ASIC, transforms any

PC/104 system into a fully-functioning GPIB Talker/Listener/Controller.

The TNT4882C chip combines the circuitry of the NAT4882 ASIC, the

Turbo488 performance-enhancing ASIC, and GPIB transceivers to create

a single-chip IEEE 488.2 Talker/Listener/Controller interface. The

TNT4882C also implements the HS488 high-speed protocol, which

increases the maximum data transfer rate of the PC/104-GPIB up to

1.5 Mbytes/s. For more information about HS488, refer to Chapter 7,

GPIB Programming Techniques, in the NI-488.2M User Manual for

Windows 95 and Windows NT.

The PC/104-GPIB is functionally identical to the AT-GPIB/TNT and can

run any NI-488.2 driver software for the AT-GPIB/TNT. The

PC/104-GPIB is available in an 8-bit version and a 16-bit version. You

can plug the 16-bit version into an 8-bit stack if you disable DMA

transfers. The PC/104-GPIB is equipped with a 20 in. ribbon cable

terminated with a panel-mount GPIB connector. You can use standard

GPIB cables to connect the PC/104-GPIB with up to 14 instruments. If

you want to use more than the maximum number of instruments, you can

order a bus extender or expander from National Instruments. Refer to

Appendix B, Specifications, for more information about the GPIB

hardware specifications and recommended operating conditions.

NI-488.2M Software Overview

The NI-488.2M software, along with the PC/104-GPIB, transforms a

PC/104 system into a GPIB Talker/Listener/Controller with complete

communications and bus management capability. The NI-488.2M

software includes the following components:

• Device driver

• Diagnostic test utility

• Configuration utility

• Interactive control program

• Utilities for software development
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• Language interface libraries for Microsoft Visual C/C++ 2.0 or

higher, Borland C/C++ 4.0 or higher, and Microsoft Visual Basic 4.0

or higher

• Example programs that use NI-488 functions and NI-488.2 routines

Refer to Appendix B, Specifications, for information about the

NI-488.2M software transfer rates.

Optional Programming Environments

Your kit includes the NI-488.2Msoftware for Windows. In addition, you

can order the LabWindows
®
/CVI or LabVIEW software from National

Instruments. LabWindows/CVI and LabVIEW include instrument driver

libraries that make it easier to communicate with your GPIB instruments.

LabWindows/CVI is an interactive ANSI C development environment for

building test and measurement and instrument control systems. It

includes interactive code-generation tools and a graphical editor for

building custom user interfaces. It also includes built-in libraries for

IEEE 488.2, VXI, RS-232 control, and plug-in data acquisition. When

you order LabWindows/CVI, you also get hundreds of complete

instrument drivers, which are modular, source-code programs that handle

the communication with your instrument so that you do not have to learn

the programming details.

LabVIEW is a complete programming environment that departs from the

sequential nature of traditional programming languages and features a

graphical programming environment. It includes all the tools needed for

instrument control, data acquisition, analysis, and presentation.

LabVIEW also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact

National Instruments.
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Hardware Configuration

and Installation
2

Chapter

This chapter contains instructions to help you configure and install your

PC/104-GPIB.

Using the Hardware Default Settings

The PC/104-GPIB default settings are suitable for most PC/104 systems.

However, if the default settings conflict with another device in your

system, if you are installing the PC/104-GPIB in an 8-bit stack, or if you

need to install more than one PC/104-GPIB, you must reconfigure the

hardware.

Table 2-1 shows the default settings for the switches and jumpers on the

PC/104-GPIB.

Table  2-1.  Hardware Default Settings

PC/104-GPIB Setting Default

Base I/O Address (hex) 2C0

DMA Channel 5

Interrupt Line (IRQ) 11

To modify the default settings of the PC/104-GPIB, skip to the Configure

the Hardware (Optional) section of this chapter. If you do not need to

reconfigure the module, continue to the next section, Install the

Hardware.
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Install the Hardware

Warning: Electrostatic discharge can damage several components on your

PC/104-GPIB. To avoid electrostatic damage when you handle the

module, touch the antistatic plastic package to a metal part of your

system chassis before you remove the module from the package.

The PC/104-GPIB is available in two versions:  stackthrough 16-bit and

stackthrough 8-bit. 16-bit modules have two PC/104 connectors and 8-bit

modules have one PC/104 connector. Verify that you have the correct

version for your system.

Perform the following steps to install the PC/104-GPIB. In this section,

the term parent module generically refers to either the parent system or

the adjacent PC/104 module you stack the PC/104-GPIB onto.

1. Power off your PC/104 system. Keep the system plugged in so that it

remains grounded while you install the PC/104-GPIB.

2. Mount the provided standoffs to the parent module before installing

the PC/104-GPIB. You might need to install the provided hex nuts

on the bottom side of the parent module to secure the standoffs in

place. Notice that the parent module might have only two mounting

holes for the standoffs instead of four; in this case, you need only

two standoffs.

3. Plug the PC/104-GPIB into the parent module. The PC/104 header is

keyed so that it fits in only one direction. Do not force the PC/104

connector into place.

After you plug in the PC/104-GPIB, ensure proper contact by gently

pressing down at the PC/104 connector region of the PC/104-GPIB

until the module is level with respect to the parent module.

4. Fasten the PC/104-GPIB to the standoffs with the provided 4-40

screws. Refer to Figure 2-1.
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1 PC/104-GPIB 5 Standoff

2 GPIB connection 6 Parent module

3 GPIB ribbon cable 7 PC/104 connector

4 Screw 8 PC/104 header

Figure 2-1.  Installing the PC/104-GPIB

5. Plug the GPIB ribbon cable into the GPIB connection on the

PC/104-GPIB. The header is keyed so that it fits in only one

direction. Do not force the GPIB ribbon cable connector into place.

The GPIB ribbon cable is 20 in. long and terminated with a

panel-mount GPIB connector that can be mounted for easy access in

your system.

Note: If you plan to perform HS488 high-speed protocol transfers, you must

configure the NI-488.2M software for the amount of GPIB cable length

in your system. You must add the 20 in. GPIB ribbon cable to your total

GPIB cable length.
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6. Check the installation.

7. Power on your system and start Windows NT.

The PC/104-GPIB hardware installation is now complete. Proceed to

Chapter 3, Software Installation and Configuration.

Configure the Hardware (Optional)

Follow the instructions in this section to change the hardware default

settings of the PC/104-GPIB before you install it.

The default settings are suitable for most PC/104 systems. However, if

the default settings conflict with another device in your system, if you are

installing the PC-104-GPIB in an 8-bit stack, or if you need to install

more than one PC/104-GPIB, you must reconfigure the hardware. If you

are installing the PC/104-GPIB in an 8-bit stack, you must configure the

PC/104-GPIB to use interrupt request level 3, 4, 5, 6 or 7 and disable

DMA.

Figure 2-2 shows the location of the configuration jumpers and switches

on the PC/104-GPIB.
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2 Serial Number 5 Interrupt Levels

3 Base I/O Address 6 Shield Ground

Figure 2-2.  PC/104-GPIB Parts Locator Diagram
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Selecting the Base I/O Address
PC/104-compatible systems have a segment of address space reserved for

input and output. This segment is called the I/O address space. The base

I/O address of a PC/104 module such as the PC/104-GPIB is the first

position in the I/O address space occupied by the PC/104 module.

By default, the PC/104-GPIB is configured to use base I/O address

2C0 hex. With this setting, the module uses the I/O address space

2C0 hex through 2DF hex. If another device is already using this address

range or if you are installing more than one PC/104-GPIB, follow these

steps to reconfigure the base I/O address setting.

1. Choose a new base I/O address setting.

You can configure the base I/O addresses to any setting between

0x100 and 0x3E0 that is a multiple of 0x20 hex. If you are installing

more than one PC/104-GPIB, each module must use a unique base

I/O address.

Table 2-2 lists the possible switch settings, the corresponding base

I/O addresses, and the I/O address space used for each setting. The

default settings are in bold italics.

Table 2-2.  Possible Base I/O Address Switch Settings

Switch Setting

A9 A8 A7 A6 A5

Base I/O

Address (hex)

I/O Address Space

Used (hex)

0 1 0 0 0 100 100 to 11F

0 1 0 0 1 120 120 to 13F

0 1 0 1 0 140 140 to 15F

0 1 0 1 1 160 160 to 17F

0 1 1 0 0 180 180 to 19F

0 1 1 0 1 1A0 1A0 to 1BF

0 1 1 1 0 1C0 1C0 to 1DF

0 1 1 1 1 1E0 1E0 to 1FF

1 0 0 0 0 200 200 to 21F

1 0 0 0 1 220 220 to 23F
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Table 2-2.  Possible Base I/O Address Switch Settings (Continued)

Switch Setting

A9 A8 A7 A6 A5

Base I/O

Address (hex)

I/O Address Space

Used (hex)

1 0 0 1 0 240 240 to 25F

1 0 0 1 1 260 260 to 27F

1 0 1 0 0 280 280 to 29F

1 0 1 0 1 2A0 2A0 to 2BF

1 0 1 1 0 2C0 2C0 to 2DF

1 0 1 1 1 2E0 2E0 to 2FF

1 1 0 0 0 300 300 to 31F

1 1 0 0 1 320 320 to 33F

1 1 0 1 0 340 340 to 35F

1 1 0 1 1 360 360 to 37F

1 1 1 0 0 380 380 to 39F

1 1 1 0 1 3A0 3A0 to 3BF

1 1 1 1 0 3C0 3C0 to 3DF

1 1 1 1 1 3E0 3E0 to 3FF

2. Locate the base I/O address switch at SW1 on your PC/104-GPIB.

Refer to the parts locator diagram, Figure 2-2.

3. Change the switch settings to configure the PC/104-GPIB to the new

base I/O address.

Press down on the side marked 1 to select a binary value of 1 for the

corresponding address bit. Press down on the 0 side of the switch to

select a binary value of 0. Refer to Figure 2-3 for an example of the

switch settings and corresponding base I/O addresses.
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Push this side down (OFF) for logic 1

Push this side down (ON) for logic 0

Switch Set to Base I/O 

Address hex 300

Switch Set to Default 

Base I/O Address hex 2C0

9

8

7

6

5

Binary Hex

0

0

3

9

8

7

6

5

Binary Hex

0

C

2

1 0

1
1

0
0
0
0

0
0
0
0

 1
0

1
1
0
0

0
0
0
0

1
2

3
4

5
1

2
3

4
5

1 0

O
F

F
O

F
F

Figure 2-3.  Base I/O Address Switch Settings

4. Record your new settings on the Hardware and Software

Configuration Form in Appendix C, Customer Communication.

5. Remember that after you install the NI-488.2M software, you must

use the GPIB Configuration utility to configure your software

settings to match your new hardware settings. Refer to the Configure

the Software (Optional) section in Chapter 3, Software Installation

and Configuration, for information about the GPIB Configuration

utility.
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Selecting the Interrupt Request Line
PC/104-compatible systems have a series of interrupt request lines

available to devices. Devices use interrupts to get immediate service from

the CPU for asynchronous events. Your GPIB hardware and the

NI-488.2M software use interrupts to get service from the CPU when

necessary.

Note: The GPIB software for Windows NT requires that the PC/104-GPIB be

configured to use an interrupt request line.

By default, the PC/104-GPIB is configured to use interrupt request

line 11. If this setting conflicts with another device in your system, if you

are installing the PC-104-GPIB in an 8-bit stack, or if you need to install

more than one PC/104-GPIB, follow these steps to reconfigure the

interrupt request line:

1. Choose a new interrupt request line (IRQ) setting.

If you are installing the PC/104-GPIB in a 16-bit stack, you can

configure it to use any of the following interrupt lines:  IRQ3, 4, 5, 6,

7, 9, 10, 11, 12, 14, or 15. You might not want to select interrupt

lines 6 or 14 because the diskette drive controller typically uses

interrupt line 6 and the hard disk drive controller uses interrupt

line 14 on most systems.

If you are installing the PC/104-GPIB in an 8-bit stack, the only

interrupt lines available to you are 3, 4, 5, 6, and 7.

If you are installing more than one PC/104-GPIB, each module must

use a unique IRQ level.

2. Find the jumpers at W1 and W3 that set the interrupt request line.

The jumpers are located on the lower edge of your PC/104-GPIB.

Refer to the parts locator diagram, Figure 2-2.

3. Change the jumper settings to configure the PC/104-GPIB to the new

interrupt request line.

To use lines 10, 11, 12, 14, or 15, use the jumper block shown in

Figure 2-4. To use interrupt lines 3, 4, 5, 6, 7, or 9, use the jumper

block shown in Figure 2-5.
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Figure 2-4 shows the setting for IRQ11.

IR
Q

 1
0

IR
Q

 1
1

IR
Q

 1
2

IR
Q

 1
4

IR
Q

 1
5

W1

Figure 2-4.  Interrupt Jumper Setting for IRQ11 (Default Setting)

Figure 2-5 shows the setting for IRQ5.

W3

IR
Q

 9

IR
Q

 7

IR
Q

 6

IR
Q

 5

IR
Q

 4

IR
Q

 3

Figure 2-5.  Interrupt Jumper Setting for IRQ5

4. Record your new setting on the Hardware and Software

Configuration Form in Appendix C, Customer Communication.

5. Remember that after you install the NI-488.2M software, you must

use the GPIB Configuration utility to configure your software

settings to match your new hardware settings. Refer to the Configure

the Software (Optional) section in Chapter 3, Software Installation

and Configuration, for information about the GPIB Configuration

utility.
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Selecting the DMA Channel
Direct memory access (DMA) refers to data transfers directly to or

directly from devices such as the PC/104-GPIB and system memory.

Your GPIB hardware and the NI-488.2M software are designed to

perform DMA. In most cases, data transfers using DMA are significantly

faster than programmed I/O transfers, which use more CPU time.

By default, the PC/104-GPIB is configured to use DMA channel 5. If this

is not an acceptable setting, if you are installing the PC/104-GPIB in an

8-bit stack, or if you are installing more than one PC/104-GPIB, follow

these steps to reconfigure the DMA channel.

Note: If you are installing the PC/104-GPIB in an 8-bit stack, you must disable

DMA, because DMA channels 5, 6, and 7 are 16-bit DMA channels.

Refer to Figure 2-8, which shows how to set the DMA jumpers for no

DMA.

1. Choose a new DMA channel setting.

You can use channel 5, 6, or 7. If you are installing more than one

PC/104-GPIB, each module must either use a unique DMA channel

or must not use DMA at all.

2. Locate the jumpers at W2 that select the DMA channel. Refer to the

parts locator diagram, Figure 2-2.

3. Change the jumper settings to configure the PC/104-GPIB to the new

DMA channel. To select a new DMA channel, you must set both the

DMA Acknowledge and DMA Request lines, as shown in Table 2-3.

Table 2-3.  DMA Channels

Signal Lines

DMA

Channel

DMA

Acknowledge

DMA

Request

5 DACK5 DRQ5

6 DACK6 DRQ6

7 DACK7 DRQ7
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Figure 2-6 shows the jumper position for selecting DMA channel 7.  

D
R

Q
7

D
R

Q
5

D
A

C
K

5

D
R

Q
6

D
A

C
K

6

D
A

C
K

7

W2

Figure 2-6.  DMA Channel Jumper Setting for DMA Channel 7

4. Record your new setting on the Hardware and Software

Configuration Form in Appendix C, Customer Communication.

5. Remember that after you install the NI-488.2M software, you must

use the GPIB Configuration utility to configure your software setting

to match your new hardware settings. Refer to the Configure the

Software (Optional) section in Chapter 3, Software Installation and

Configuration, for information about the GPIB Configuration utility.

Using Programmed I/O for GPIB Transfers
As an alternative to DMA transfers, you can use programmed I/O. To use

programmed I/O, you should disable DMA for the PC/104-GPIB by

moving the jumpers as shown in Figure 2-7.

D
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Q
7

D
R

Q
5

D
A

C
K

5

D
R

Q
6

D
A

C
K

6

D
A

C
K

7

W2

Figure 2-7.  DMA Jumper Setting for No DMA Channel
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Setting the Shield Ground Configuration
The PC/104-GPIB is set at the factory with the jumper in place to connect

the logic ground of the PC/104-GPIB to its shield ground. This

configuration minimizes EMI emissions.

Caution: The PC/104-GPIB was tested for compliance with FCC standards with

the shield ground connected to logic ground. Removing the jumper might

cause EMI emissions to exceed any or all of the applicable standards

If your application requires that logic ground be disconnected from shield

ground, follow these steps:

1. Refer to Figure 2-2 to locate the shield ground jumper W5 on the

PC/104-GPIB module.

2. Remove the jumper and place it across only one of the jumper pins,

as shown in Figure 2-8.

Logic Ground Connected to Shield Ground (Default)

Logic Ground Disconnected from Shield Ground

W5

W5

Figure 2-8.  Ground Configuration Jumper Settings

3. Record the jumper setting on the Hardware and Software

Configuration Form in Appendix C, Customer Communication.

Now that you have properly configured the hardware, return to the Install

the Hardware section at the beginning of this chapter for the installation

instructions.
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Software Installation

and Configuration
3

Chapter

This chapter contains instructions to help you install and configure your

NI-488.2M software for Windows NT.

Install the Software

After you have installed and configured the hardware, you are ready to

install the NI-488.2M software. Complete the following steps to run the

software installation program.

Note: The PC/104-GPIB is functionally identical to the AT-GPIB/TNT.

Therefore, the NI-488.2M software for Windows NT refers to the

PC/104-GPIB as an AT-GPIB/TNT.

1. Log onto your Windows NT system using the Administrator

account. The NI-488.2M installation program must have

Administrator privileges because the program modifies the

configuration registry of your system.

2. Insert the NI-488.2M software for Windows NT distribution disk

into an unused drive.

3. Windows NT 3.51:  Select Run... from the File menu in the

Program Manager.

Windows NT 4.0 or higher:  Select Run... from the Start menu.

Type the following command into the dialog box:

x:\setup

where x is the letter of the drive containing the distribution disk

(usually a or b).
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The software installation begins with the screen shown in Figure 3-1.

Figure 3-1.  NI-488.2M Software for Windows NT Installation Screen

The setup program takes you through the necessary steps to install

the NI-488.2M software. For help during the installation, click on the

Help button. You can exit the setup program at any time by clicking

on the Exit button.

When the setup program has finished copying the software onto your

system, it attempts to start the NI-488.2M driver. If the setup

program cannot start the driver, it instructs you to restart

Windows NT, which forces the driver to load.

If you modified the hardware configuration or installed more than one

PC/104-GPIB, you must reconfigure the software. Refer to the next

section, Configure the Software (Optional), for instructions on running

the GPIB Configuration utility. If you do not need to run the GPIB

Configuration utility because you are using the default hardware settings,

refer to Chapter 4, Installation Verification, for instructions on verifying

the hardware and software installation.
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Configure the Software (Optional)

The GPIB Configuration utility is an interactive utility you can use to

examine or modify the configuration of the driver. You must run the

GPIB Configuration utility if you changed any of the hardware default

settings or if you installed more than one PC/104-GPIB. Follow these

steps to run the utility:

1. Double-click on the GPIB icon in the Control Panel.

Windows NT 3.51:  Open the Control Panel in the Main group of

the Program Manager.

Windows NT 4.0 or higher:  Select Start»Settings»Control Panel.

The GPIB Configuration utility displays a list of all the GPIB boards

and device names.

2. Use the Board Type button to specify the type of GPIB interface.

For the PC/104-GPIB, select the AT-GPIB/TNT Board Type.

3. Double-click on any name to examine or edit it. For more

information about GPIB Configuration utility options, refer to the

NI-488.2M User Manual for Windows 95 and Windows NT or use the

online help.

4. Click on the OK button to save your changes.

After you have installed and configured the software, you should verify

the installation. Continue to the next chapter, Chapter 4, Installation

Verification.
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Installation Verification
4

Chapter

This chapter describes how to verify the hardware and software

installation.

You can use the Diagnostic utility, installed with your GPIB software, to

test the hardware and software installation. The Diagnostic utility verifies

that your hardware and software are functioning properly and that the

configuration of your GPIB interfaces does not conflict with anything

else in your system.

Follow these instructions to run the Diagnostic utility:

Windows NT 3.51:  Double-click on the Diagnostic icon in the

NI-488.2M Software for Windows NT group of the Program

Manager.

Windows NT 4.0 or higher:  Select the Diagnostic item under

Start»Programs»NI-488.2M Software for Windows NT.

When you have started the Diagnostic utility, test your GPIB interfaces

by clicking on the Test All button. If the Diagnostic utility test is

successful, it puts a check mark next to the interface and changes its

status from untested to passed. If the Diagnostic utility test fails, it puts

an X next to the interface, and changes its status from untested to failed.

Figure 4-1 shows the Diagnostic utility dialog box after it has tested some

GPIB interfaces.
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Figure 4-1.  Diagnostic Utility after Testing

PC/104-GPIB boards show up as an AT-GPIB/TNT interface type. You

can get details on any of the tested GPIB interfaces by selecting the

interface and clicking on the Details button. For each failed GPIB

interface, select it and click on the Details button to get a description of

the failure encountered. Use that information and the information in

Appendix A, Troubleshooting and Common Questions, to troubleshoot

the problem. There is also extensive troubleshooting information in the

Diagnostic online help.
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Using the GPIB Software
5

Chapter

This chapter helps you get started with the NI-488.2M software for

Windows NT.

Introduction to the Win32 Interactive Control Utility

You can use the interactive control utility to enter NI-488 functions and

NI-488.2 routines interactively and see the values the function calls

return. You can use this utility to do the following:

• Verify GPIB communication with your device quickly and easily.

• Learn the NI-488 functions and NI-488.2 routines before you write

your application.

• Become familiar with the commands of your device.

• Receive data from your GPIB device.

• Troubleshoot problems with your application.

Follow these instructions to run the Win32 Interactive Control Utility:

Windows NT 3.51:  Double-click on the Win32 Interactive Control

icon in the NI-488.2M Software for Windows NT group of the

Program Manager.

Windows NT 4.0 or higher:  Select the Win32 Interactive Control item

under Start»Programs»NI-488.2M Software for Windows NT.

This utility includes extensive online help, which you can access by

entering help at the : prompt. For more information about the Win32

Interactive Control utility, refer to the NI-488.2M User Manual for

Windows 95 and Windows NT.
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Introduction to the GPIB Spy Utility

Included with the NI-488.2M software is GPIB Spy, a Win32 utility that

you can use to monitor NI-488.2M calls made by Win32, Win16, and

DOS GPIB applications. You can use GPIB Spy to do the following:

• Capture information about NI-488 functions and NI-488.2M routines

as your GPIB applications invoke them.

• Display captured information, including, but not limited to, input and

output parameter values, I/O buffer contents, and return values.

• Save, restore, and print captured information.

Follow these instructions to run GPIB Spy:

Windows NT 3.51:  Double-click on the GPIB Spy icon in the

NI-488.2M Software for Windows NT group of the Program

Manager.

Windows NT 4.0 or higher:  Select the GPIB Spy item under

Start»Programs»NI-488.2M Software for Windows NT.

For more information about the GPIB Spy utility, refer to Chapter 5,

GPIB Spy Utility, in the NI-488.2M User Manual for Windows 95 and

Windows NT, or use the GPIB Spy context-sensitive online help.

General Programming Considerations

As you begin developing your Win32 NI-488.2M application, remember

the following points:

• For your C/C++ application, you must include the NI-488.2M header

file in your source code.

• You can access the NI-488.2M software through the 32-bit DLL,

gpib-32.dll, either by linking with one of the language

interfaces provided with the NI-488.2M software, or by using direct

DLL entry from any programming environment.

• Several sample GPIB applications are included with the NI-488.2M

software. Use these as a guide for your own application

development.
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For information about choosing a programming method, developing your

application, or compiling and linking, refer to the NI-488.2M User

Manual for Windows 95 and Windows NT. For detailed information about

each NI-488 function and NI-488.2 routine, refer to the NI-488.2M

Function Reference Manual for Win32.

Running Existing DOS and Windows GPIB Applications

You can run existing DOS and Windows GPIB applications under

Windows NT by using the GPIB Virtual Device Driver, gpib-vdd.dll,

which your NI-488.2M software includes.

To run DOS GPIB applications, load the special GPIB device driver

gpib-nt.com instead of gpib.com, which you normally use with DOS.

When you install the NI-488.2M software, the installation program

copies gpib-nt.com into a new subdirectory called doswin16. To

use gpib-nt.com, you must modify your config.nt file to

load gpib-nt.com whenever a DOS application runs. The config.nt

file is located in your winnt\system32 directory, where winnt is your

Windows NT directory, for example, c:\windows. To load

gpib-nt.com, add the following line to your config.nt file:

device=path\doswin16\gpib-nt.com

where path is the directory where you installed the GPIB software (the

default installation directory is c:\gpib-nt).

To run 16-bit Windows GPIB applications, the system uses the special

GPIB dynamic link library, gpib.dll. When you install the NI-488.2M

software, the installation program copies gpib.dll into the

winnt\system32 directory, where winnt is your Windows NT

directory, for example c:\windows. As long as gpib.dll is in your

Windows NT directory, your system automatically accesses gpib.dll

whenever you launch a 16-bit Windows GPIB application.
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Troubleshooting and

Common Questions
A

Appendix

This appendix contains troubleshooting information and the answers to

common questions.

Troubleshooting Diagnostic Utility Failures

The following sections explain common error messages the Diagnostic

utility generates.

Missing Software Components
This error occurs if the software components that are necessary for the

GPIB software for Windows NT to function correctly are not present in

the system. If you encounter this problem, reinstall the GPIB software for

Windows NT and run the Diagnostic utility again.

No GPIB Interfaces Present
This error occurs if there is no PC/104-GPIB physically present in the

system or there is a resource conflict with the interfaces that are installed.

If you encounter this problem, use the GPIB Configuration utility to

examine any installed GPIB interfaces and the resources assigned to

each. Then, run the Diagnostic utility again.

To access this information in the GPIB Configuration utility, complete

the following steps:

1. Double-click on the GPIB icon in the Control Panel.

Windows NT 3.51:  Open the Control Panel in the Main group of

the Program Manager.

Windows NT 4.0 or higher:  Select Start»Settings»Control Panel.
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2. Click on the Board Type button and verify that the type of

GPIB interface listed for each logical board name is correct. Click

on the OK button to return to the main dialog box.

3. Double-click on each board name and verify that the hardware

settings displayed in the dialog box match your actual hardware

settings.

GPIB Cables Need to Be Disconnected
This error occurs if you have any GPIB cables connected to the

PC/104-GPIB. Disconnect all GPIB cables and run the Diagnostic utility

again.

Address Resource Conflict
This error occurs if the address resources assigned to a PC/104-GPIB

conflict with the address resources that other devices in the system are

using. To resolve an address resource conflict, refer to the Resolving

Resource Conflicts section later in this appendix. After you have resolved

the conflict, run the Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a PC/104-GPIB

conflict with the interrupt resources that other devices in the system are

using. To resolve an interrupt resource conflict, refer to the Resolving

Resource Conflicts section later in this appendix. After you have resolved

the conflict, run the Diagnostic utility again.

DMA Resource Conflict
This error occurs if the DMA resources assigned to a PC/104-GPIB

conflict with the DMA resources that other devices in the system are

using. To resolve a DMA resource conflict, refer to the Resolving

Resource Conflicts section later in this appendix. After you have resolved

the conflict, run the Diagnostic utility again.

Single-Cycle DMA Required
This error occurs if the Diagnostic utility detects that it is unable to

perform demand-mode DMA for the PC/104-GPIB and that you have not

configured the GPIB software to use single-cycle DMA. If you encounter
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this error, you should use the GPIB Configuration utility to configure the

NI-488.2M software to use single-cycle DMA for all DMA transfers, and

then run the Diagnostic utility again.

To configure the NI-488.2M software to use single-cycle DMA for the

PC/104-GPIB, complete the following steps.

1. Double-click on the GPIB icon in the Control Panel.

Windows NT 3.51:  Open the Control Panel in the Main group of

the Program Manager.

Windows NT 4.0 or higher:  Select Start»Settings»Control Panel.

2. Double-click on AT-GPIB/TNT.

3. Make sure that the Use Demand Mode DMA item is unchecked.

GPIB Software Problem Encountered
This error occurs if the Diagnostic utility detects that it is unable to

communicate correctly with the GPIB hardware using the installed GPIB

software. If you encounter this error, shut down your system, restart it,

and run the Diagnostic utility again. If the problem persists, try

reinstalling the GPIB software for Windows NT.

Unknown Problem Encountered
This error occurs if an unknown problem is encountered when you try to

execute the Diagnostic utility. If this error occurs, shut down your

system, restart it, and run the Diagnostic utility again. If the problem

persists, try reinstalling the GPIB software for Windows NT.

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is

configured to use the same resources as your PC/104-GPIB. The

NI-488.2M driver detects some resource conflicts when it loads. When

the driver detects conflicts as it loads, it records an error message

describing the conflict. You can use the Event Viewer, as described in

the following section, Using Windows NT Diagnostic Tools, to see which

resource is in conflict.

Once you have identified the resource that caused the conflict, use the

GPIB Configuration utility to reconfigure your PC/104-GPIB so that it



Appendix A    Troubleshooting and Common Questions

PC/104-GPIB for Windows NT A-4 © National Instruments Corporation

uses conflict-free resources. To help in the selection of conflict-free

resources, Microsoft has provided a utility called Windows NT

Diagnostics. This utility displays a list of the I/O port addresses, interrupt

levels, and DMA channels that are currently being used in your system.

Use system resources that this utility does not list when you assign

resources to your PC/104-GPIB.

Follow these instructions to run the Windows NT Diagnostics utility:

Windows NT 3.51:  Double-click on the Windows NT Diagnostics icon

in the Administrative Tools group of the Program Manager.

Windows NT 4.0 or higher:  Select Start»Programs»Administrative

Tools»Windows NT Diagnostics.

Note: For 8-bit operation, you must disable DMA and use only interrupt

request line 3, 4, 5, 6, or 7.

Using Windows NT Diagnostic Tools

There are many reasons why the NI-488.2M driver might not load. If the

software is not properly installed or if there is a conflict between the

GPIB hardware and the other hardware in the system, the NI-488.2M

driver fails to start. Two Windows NT utilities are useful in determining

the source of the problem: the Devices applet in the Control Panel, and

the Event Viewer. The following sections describe the information

available through each utility.

Examining NT Devices to Verify the NI-488.2M Installation
To verify whether the NI-488.2M devices are installed correctly (that is,

that the devices are started), run the Devices applet in the Control Panel,

as shown in the following paragraphs.

Windows NT 3.51:  Open the Control Panel in the Main group of the

Program Manager.

Windows NT 4.0 or later:  Select Start»Settings»Control Panel.
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This utility lists all of the devices Windows NT detects. Each device has

a status associated with it. If the NI-488.2M driver is installed correctly,

the following lines appear in the list of NT devices:

Device Status Started

GPIB Board Class Driver Started Automatic

GPIB Device Class Driver Started Automatic

You should also see one or more lines similar to the following:

Device Status Started

GPIB Port Driver (AT-GPIB) **** System

GPIB Port Driver (PCI-GPIB) **** System

The GPIB Board Class Driver, the GPIB Device Class Driver, and at

least one of the GPIB Port Drivers listed by the Devices applet should

have a status of Started. If not, refer to the next section, Examining the

NT System Log Using the Event Viewer.

If the GPIB Class Driver lines are not present or at least one GPIB Port

Driver line is not present, the NI-488.2M software is not installed

properly. You must reinstall the NI-488.2M software. Refer to Chapter 3,

Software Installation and Configuration.

Examining the NT System Log Using the Event Viewer
Windows NT maintains a system log. If the NI-488.2M driver is unable

to start, it records entries in the system log explaining why it failed to

start. You can examine the system log by running the Event Viewer

utility, as shown in the following paragraphs.

Windows NT 3.51:  Double-click on the Event Viewer icon in the

Administrative Tools group of the Program Manager.

Windows NT 4.0 or higher:  Select Start»Programs»Administrative

Tools»Event Viewer. Events that might appear in the system log include

the following:

• The system cannot locate the device file for one or more of the

devices that make up the NI-488.2M driver and an event is logged

that The system cannot find the file specified. In this

case, the NI-488.2M software is incorrectly installed. You should

reinstall the software.
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• A conflict exists between the GPIB hardware and the other hardware

in the system. If this is the case, an event is logged that indicates the

nature of the resource conflict. To correct this conflict, reconfigure

the GPIB hardware and the NI-488.2M software. Refer to Chapter 2,

Hardware Configuration and Installation, and Chapter 3, Software

Installation and Configuration, for configuration information.

Common Questions

How can I determine which type of GPIB hardware I have installed?

Run the GPIB Configuration utility. To run the utility, open your

Windows NT Control Panel and select the National Instruments eagle

icon.

Note: The PC/104-GPIB is functionally identical to the AT-GPIB/TNT.

Therefore, the NI-488.2M software for Windows NT refers to the

PC/104-GPIB as an AT-GPIB/TNT.

How can I determine which version of the NI-488.2M software I have installed?

Run the Diagnostic utility, as follows:

Windows NT version 3.51:  Start the Diagnostic utility by

double-clicking on the Diagnostic icon in the NI-488.2M Software for

Windows NT group of the Program Manager.

Windows NT version 4.0 or later:  Start the Diagnostic utility by

choosing the Diagnostic item under Start»Programs»NI-488.2M

Software for Windows NT.

How many GPIB interfaces can I configure for use with my NI-488.2M Software

for Windows NT?

You can configure the NI-488.2M Software for Windows NT to

communicate with up to 4 GPIB interfaces.

How many devices can I configure for use with my NI-488.2M Software for

Windows NT?

The NI-488.2M Software for Windows NT provides a total of 100 logical

devices for applications to use. The default number of devices is 32.
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Are interrupts and DMA required with the NI-488.2M Software for

Windows NT?

Interrupts are required, but DMA is not.

How can I determine if my GPIB hardware and software are correctly installed?

Run the Diagnostic utility, as follows:

Windows NT version 3.51:  Start the Diagnostic utility by

double-clicking on the Diagnostic icon in the NI-488.2M Software for

Windows NT group of the Program Manager.

Windows NT version 4.0 or later:  Start the Diagnostic utility by

choosing the Diagnostic item under Start»Programs»NI-488.2M

Software for Windows NT.

When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify

instrument communication, troubleshoot problems, and develop your

application. For more information, refer to Chapter 6, Win32 Interactive

Control Utility, in the NI-488.2M User Manual for Windows 95 and

Windows NT.

How do I use an NI-488.2M language interface?

For information about using NI-488.2M language interfaces, refer to

Chapter 3, Developing Your Application, in the NI-488.2M User Manual

for Windows 95 and Windows NT.

What do I do if the Diagnostic utility fails with an error?

Use the Diagnostic online help, or refer to the getting started manual, to

troubleshoot specific problems. If you have already completed the

troubleshooting steps, fill out the support forms in Appendix C, Customer

Communication, and contact National Instruments.

How do I communicate with my instrument over the GPIB?

Refer to the documentation that came from the instrument manufacturer.

The command sequences you use are totally dependent on the specific

instrument. The documentation for each instrument should include the

GPIB commands you need to communicate with it. In most cases, NI-488

device-level calls are sufficient for communicating with instruments.
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Refer to Chapter 3, Developing Your Application, in the NI-488.2M User

Manual for Windows 95 and Windows NT, for more information.

Can I use the NI-488 and NI-488.2 calls together in the same application?

Yes, you can mix NI-488 functions and NI-488.2 routines.

What can I do to check for errors in my GPIB application?

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call

fails, the ERR bit of ibsta is set and an error code is stored in iberr.

For more information about global status variables, refer to Chapter 3,

Developing Your Application, in the NI-488.2M User Manual for

Windows 95 and Windows NT.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the

Diagnostic test. Also, make sure you have filled out the technical support

form in Appendix C, Customer Communication.
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Specifications
B

Appendix

This appendix describes the physical characteristics of the PC/104-GPIB

and the transfer rates of the NI-488.2M software, along with the

recommended operating conditions.

Hardware Characteristics

Table B-1.  PC/104-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 9.017 cm by 9.589 cm

(3.55 in. by 3.775 in. )

Power Requirement

(from PC AT I/O Channel)

+5 VDC 50 mA Typical

120 mA Maximum

I/O Connector 20 in. Ribbon Cable Terminated

with Panel-Mount IEEE 488

Standard 24-Pin

Operating Environment

  Ambient Temperature

  Relative Humidity

-40° to 85° C

10% to 90%, Noncondensing

Storage Environment

  Temperature

  Relative Humidity

-40° to 85° C

5% to 90%, Noncondensing

EMI FCC Class A Verified
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Software Transfer Rates

Table B-2.  NI-488.2M Software Transfer Rates for the PC/104-GPIB

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 1.8 Mbytes/s*

* Actual speed may vary considerably from speed shown because of

system and instrumentation capabilities.



© National Instruments Corporation C-1 PC/104-GPIB for Windows NT

Customer Communication
C

Appendix

For your convenience, this appendix contains forms to help you gather the information necessary to
help us solve technical problems you might have as well as a form you can use to comment on the
product documentation. Filling out a copy of the Technical Support Form before contacting
National Instruments helps us help you better and faster.

National Instruments provides comprehensive technical assistance around the world. In the U.S. and
Canada, applications engineers are available Monday through Friday from 8:00 a.m. to 6:00 p.m.
(central time). In other countries, contact the nearest branch office. You may fax questions to us at
any time.

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded instructions on
how to use the bulletin board and FTP services and for BBS automated information, call
(512) 795-6990. You can access these services at:

United States:  (512) 794-5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use
your Internet address, such as joesmith@anywhere.com, as your password. The support files and
documents are located in the /support directories.



Fax-on-Demand Support

Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone at
(512) 418-1111.

E-Mail Support (currently U.S. only)

You can submit technical support questions to the applications engineering team through e-mail at
the Internet address listed below. Remember to include your name, address, and phone number so
we can contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country, contact
the source from which you purchased your software to obtain support.

Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 5734815 03 5734816

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

U.K. 01635 523545 01635 523154



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our applications
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Fax ( ____  ) _________________________ Phone ( ____ ) ___________________________

System brand ___________________ Model ______________ Processor ________________

Operating system (include version number) ____________________________________________

Clock Speed ________ MHz RAM _________ MB Display adapter ________________

Mouse ____ yes _____ no Other adapters installed _____________________________

Hard disk capacity ________  MB Brand ____________________________________________

Instruments used __________________________________________________________________

National Instruments hardware product model _____________________ Revision ____________

Configuration ____________________________________________________________________

National Instruments software product ___________________________ Version ____________

Configuration ____________________________________________________________________

The problem is ___________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

List any error messages ____________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

The following steps will reproduce the problem _________________________________________

________________________________________________________________________________

________________________________________________________________________________





Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item.
Complete a new copy of this form each time you revise your software or hardware configuration,
and use this form as a reference for your current configuration. Completing this form accurately
before contacting National Instruments for technical support helps our applications engineers answer
your questions more efficiently.

National Instruments Products

GPIB Interface Type and Revision ___________________________________________________

GPIB Software for Windows NT Version Number on Disk ________________________________

Programming Language Interface Version _____________________________________________

Diagnostic Utility Results __________________________________________________________

Other Products

Resource Summary Report from the Device Manager
To create this report, first display the System Properties dialog box for the system by
double-clicking on the System icon under Start»Settings»Control Panel. Then click on the Device
Manager tab and highlight the Computer icon. Click on the Print button, and check the Print to
file checkbox in the Print dialog box before clicking on OK.

_______________________________________________________________________________

_______________________________________________________________________________

Programming Environment Information

Programming Language ___________________________________________________________

Compiler Vendor                                                Compiler Version _______________________

Application Information

DOS Application                         Win16 Application ___________  Win32 Application _________

_______________________________________________________________________________

If Win16 or Win32, method of accessing DLL (link with language interface or direct entry?)

_______________________________________________________________________________





Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products.
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your PC/104-GPIB Hardware and the NI-488.2M™ Software for

Windows NT

Edition Date: May 1997

Part Number: 321375A-01

Please comment on the completeness, clarity, and organization of the manual.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

Thank you for your help.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Phone ( ____  ) _________________________________________________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX  78730-5039
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Glossary

Prefix Meaning Value

m- milli- 10-3

c- centi- 10-2

k- kilo- 103

M- mega- 106

° degrees

% percent

A amperes

ANSI American National Standards Institute

ASIC application-specific integrated circuit

C Celsius

CE Conformite Europeene

CPU central processing unit

DMA direct memory access

FCC Federal Communications Commission

GPIB General Purpose Interface Bus
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hex hexadecimal

Hz hertz

I/O input/output

IEEE Institute of Electrical and Electronic Engineers

in. inches

IRQ interrupt request

m meters

MB megabytes of memory

PC personal computer

RAM random-access memory

s seconds

VDC volts direct current
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